
 หน่วยที่ 4 

การออกแบบภาพกราฟิกและภาพเคลื่อนไหวในงานเว็บไซต์ 

หัวข้อ (Topics) 

4.1  ความหมายและความส าคัญของภาพกราฟิกส าหรับเว็บไซต์ 
4.2  การออกแบบภาพกราฟิกที่ใช้ส าหรับเว็บไซต์ 
4.3  ความหมายและความส าคัญของภาพเคลื่อนไหวส าหรับเว็บไซต์ 
4.4  การออกแบบภาพเคลื่อนไหวที่ใช้ส าหรับเว็บไซต์  

แนวคิด ( Main Idea) 

การพัฒนาเว็บไซต์ในงานธุรกิจให้ประสบผลส าเร็จนั้นจะต้องมีการศึกษาข้อมูลพ้ืนฐาน   
เพ่ือให้สามารถออกแบบและพัฒนาเว็บไซต์ในงานธุรกิจได้อย่างเหมาะสมในหน่วยนี้ประกอบด้วย
เนื้อหาที่จ าเป็นต้องเรียนรู้  ได้แก่ ความหมายและความส าคัญของภาพกราฟิกส าหรับเว็บไซต์        
การออกแบบภาพกราฟิกที่ใช้ส าหรับเว็บไซต์ ความหมายและความส าคัญของภาพเคลื่อนไหวส าหรับ
เว็บไซต์ และการออกแบบภาพเคลื่อนไหวที่ใช้ส าหรับเว็บไซต์  

สมรรถนะย่อย (Element of Competency) 
1. แสดงความรู้เกี่ยวกับความหมายและความส าคัญของภาพกราฟิกส าหรับเว็บไซต์ 
2. ออกแบบภาพกราฟิกท่ีใช้ส าหรับเว็บไซต์ 
3. แสดงความรู้เกี่ยวกับความหมายและความส าคัญของภาพเคลื่อนไหวส าหรับเว็บไซต์ 
4. ออกแบบภาพเคลื่อนไหวที่ใช้ส าหรับเว็บไซต์  

จุดประสงค์เชิงพฤติกรรม (Behavioral Objectives)  

1. อธิบายความหมายและความส าคัญของภาพกราฟิกส าหรับเว็บไซต์ 
2. สามารถออกแบบภาพกราฟิกที่ใช้ส าหรับเว็บไซต์ 
3. อธิบายความหมายและความส าคัญของภาพเคลื่อนไหวส าหรับเว็บไซต์ 
4. สามารถออกแบบภาพเคลื่อนไหวที่ใช้ส าหรับเว็บไซต์  
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4.1 ความหมายและความส าคัญของภาพกราฟิกส าหรับเว็บไซต์ 

ภาพกราฟิก คือ ภาพที่ผ่านการตกแต่งด้วยโปรแกรมคอมพิวเตอร์ อาจเป็นภาพที่ถูกวาด
ขึ้นมาใหม่ทั้งหมด หรือเป็นการน าภาพถ่ายมาท าการรีทัชตัดต่อโดยใช้โปรแกรมกราฟิกมาสร้างสรรค์
จนได้ภาพที่สมบูรณ์ก็ได้ เช่น โปรแกรม Paint, illustrator, Photoshop เป็นต้น การใช้ภาพกราฟิก 
ในการน าเสนอข้อมูลต่าง ๆ การใช้รูปภาพกราฟิกส าหรับเว็บไซต์โดยข้อมูลในรูปแบบของรูปภาพ  
เป็นที่นิยมในปัจจุบันมากเพราะรูปภาพท าให้เว็บไซต์มีความสวยงามและดึงดูดความสนใจจากผู้ใช้งาน
โดยทั่วไปชนิดของรูปภาพที่ปรากฏบนเครื่องคอมพิวเตอร์ สามารถแบ่งออกตามลักษณะการจัดเก็บ
ข้อมูลได ้2 ชนิดด้วยกันคือ รูปภาพแบบ Raster หรือ Bitmap และรูปภาพแบบ Vector 
  1) ภาพกราฟิกแบบ Raster หรือเรียกอีกอย่างหนึ่งว่า แบบ Bitmap เป็นภาพกราฟิก    
ที่เกิดจากการเรียงตัวของจุดสี่เหลี่ยมเล็ก ๆ หลากหลายสี ที่เรียกว่า พิกเซล ในการสร้างภาพกราฟิก
แบบ Raster จะต้องก าหนดจ านวนพิกเซลให้กับภาพที่ต้องการสร้าง ถ้าก าหนดจ านวนพิกเซลน้อย 
เมื่อขยายภาพให้มีขนาดใหญ่ขึ้น ท าให้ภาพแตกมองเห็นภาพเป็นจุดสี่เหลี่ยมเล็ก ๆ หรือถ้าก าหนด
จ านวนพิกเซลมากก็ท าให้แฟ้มภาพมีขนาดใหญ่ ดังนั้น การก าหนดจ านวนพิกเซลจึงควรก าหนดให้
เหมาะสมกับงานที่จะสร้าง เช่น งานที่มีความละเอียดน้อย หรือภาพส าหรับเว็บไซต์ ควรก าหนด
จ านวนพิกเซล ประมาณ 72 ppi (pixel / inch คือ จ านวนพิกเซลใน 1 ตารางนิ้ว) แต่ถ้าเป็นงาน 
แบบพิมพ์ เช่น นิตยสาร ปกหนังสือ โปสเตอร์ขนาดใหญ่ จะก าหนดประมาณ 300 - 350 ppi เป็นต้น 
ข้อดีของภาพกราฟิกแบบ Raster คือ สามารถปรับแต่งสี ตกแต่งภาพได้ง่ายและสวยงามซึ่งโปรแกรม
ที่นิยมใช้สร้างภาพกราฟิกแบบ Raster คือ Photoshop, Paint เป็นต้น แฟ้มภาพกราฟิกแบบ 
Raster (Bitmap) และคุณลักษณะของแฟ้มภาพกราฟิกนามสกุลที่ใช้เก็บแฟ้มภาพกราฟิกแบบ 
Raster มีหลายนามสกุล เช่น .BMP, .DIB, .JPG, .JPEG, .GIF, .TIFF, .TIF, .PCX, .MSP, .PCD, .PCT, 
.FPX, .IMG, .MAC, .MSP, .TGA เป็นต้น ซึ่งลักษณะของแฟ้มภาพจะแตกต่างกันออกไปใช้ส าหรับ
รูปภาพทั่วไป งานเว็บเพจ และงานที่มีความจ ากัดด้านพ้ืนที่นิยมใช้ไฟล์นามสกุล .JPG , .JPEG, .GIF 
เป็นต้น 
                 ภาพที่ไม่ขยาย                                   ภาพที่มีการขยายขนาดออก 

 
 

รูปภาพที่ 4.1 ตัวอย่างของภาพแบบ Raster นามสกุล.JPG เมื่อไม่ขยายและขยาย 
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  2) ภาพกราฟิกแบบ Vector หรือ Object-Oriented Graphics เป็นภาพที่มีลักษณะของ
การสร้างจากคอมพิวเตอร์ที่มีการสร้างให้แต่ละส่วนของภาพเป็นอิสระต่อกัน เป็นภาพกราฟิกที่เกิด
จากการอ้างอิงความสัมพันธ์ทางคณิตศาสตร์ หรือการค านวณ ซึ่งภาพจะมีความเป็นอิสระต่อกัน   
โดยแยกชิ้นส่วนของภาพทั้งหมดออกเป็นเส้นตรง เส้นโค้ง รูปทรง เมื่อมีการขยายภาพความละเอียด
ของภาพจะไม่ลดลง แฟ้มมีขนาดเล็กกว่าแบบ Raster ภาพกราฟิกแบบ Vector นิยมใช้เพ่ืองาน
สถาปัตยกรรมตกแต่งภายใน และการออกแบบต่าง ๆ  เช่น การออกแบบรถยนต์ การออกแบบอาคาร 
การสร้างการ์ตูน โลโก้ เป็นต้น ซึ่งโปรแกรมที่นิยมใช้สร้างภาพแบบ Vector คือ โปรแกรม 
Illustrator, CorrelDraw,3DMax แต่อุปกรณ์ท่ีใช้แสดงผลภาพ เช่น จอคอมพิวเตอร์ หรือเครื่องพิมพ์ 
เป็นการแสดงผลภาพแบบ Raster นามสกุลที่ใช้เก็บแฟ้มภาพกราฟิกแบบ Vector มีหลายนามสกุล 
เช่น .EPS, .WMF, .CDR, .AI, .CGM ,.DRW, .PLT, .DXF, .PIC และ .PGL เป็นต้น ซึ่งลักษณะของ
แฟ้มภาพจะแตกต่างกันออกไป .AI  .EPS ใช้ส าหรับงานที่ต้องการความละเอียดของภาพมาก เช่น 
การสร้างการ์ตูน การสร้างโลโก้ โปรแกรมท่ีใช้สร้าง Illustrator เป็นต้น 
 

              ภาพที่ไม่ขยาย                                ภาพที่มีการขยายขนาดออก 

 
 

รูปภาพที่ 4.2 ตัวอย่างของภาพแบบ Vector เมื่อไม่ขยายและขยาย 
 

4.2 การออกแบบภาพกราฟิกที่ใช้ส าหรับเว็บไซต์ 
 ภาพกราฟิกเป็นอีกองค์ประกอบหนึ่งที่ส าคัญส าหรับการสร้างเว็บไซต์เพราะช่วยท าให้เว็บไซต์
สวยงาม มีสีสันน่าสนใจ และสื่อความหมายได้ดีขึ้น เว็บไซต์ส่วนใหญ่จึงนิยมน าภาพกราฟิกมาใช้
ตกแต่งและประกอบเนื้อหาเพ่ือให้ท าความเข้าใจได้ง่ายขึ้น ภาพกราฟิกในระบบคอมพิวเตอร์มีหลาย
รูปแบบด้วยกัน แต่ที่นิยมใช้บนเว็บไซต์ต่าง ๆ จะมีอยู่ 3 ชนิดได้แก่ ไฟล์นามสกุล.GIF ,.JPG และ ไฟล์
นามสกุล.PNG ซ่ึงไฟล์แต่ละนามสกุลมีข้อจ ากัดและความเหมาะสมส าหรับลักษณะภาพที่แตกต่างกัน  
โปรแกรมที่ใช้ในการออกแบบภาพกราฟิกที่ใช้ส าหรับเว็บไซต์ คือ โปรแกรม Adobe Photoshop 
CS6 ซึ่งเป็นโปรแกรมที่มีความนิยมสูง และเหมาะส าหรับการสร้างชิ้นงานด้านกราฟิก การแก้ไขภาพ 
และการออกแบบภาพประเภทต่าง ๆ  ซึ่งมีส่วนประกอบของโปรแกรมดังนี้ 
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 1.  แถบเมนูค าสั่ง (Menu Bar) คือ แถบทีร่วบรวมชุดค าสั่งใช้ส าหรับเรียกค าสั่งต่าง ๆ 
เพ่ือใช้จัดการไฟล์ภาพหรือตกแต่งภาพ 

 2. แถบตัวเลือก (Options Bar) คือ แถบที่ใช้ในการปรับแต่งค่าการท างานของ
เครื่องมือต่าง ๆ การก าหนดค่าในแถบตัวเลือกจะเปลี่ยนไปตามเครื่องมือที่ใช้งานอยู่ 

 3. กล่องเครื่องมือ (Toolbox) คือ แถบที่ใช้เก็บเครื่องมือพ้ืนฐานในการท างาน       
ในโปรแกรมสามารถเรียกใช้ชุดเครื่องมือย่อยโดยการคลิกรูปสามเหลี่ยมที่มุมด้านล่าง 

 4.  พาเนล (Panel) คือหน้าต่างการท างานย่อย ๆ ใช้ส าหรับจัดการกับภาพโดยแยก
ออกเป็นหมวดหมู่ เช่น พาเนลส าหรับเลือกสี พาเนลส าหรับปรับแต่งความสว่าง เป็นต้น พาเนลแต่ละ
แบบมีหน้าที่และการใช้งานแตกต่างกันออกไปสามารถเลือกเปิดหรือปิดพาเนลได้จากเมนูค าสั่ง 
Window 

 5. พ้ืนที่การท างาน (Stage) คือ พ้ืนที่ส าหรับการท างานที่ใช้สร้างภาพกราฟิกและ
ตกแต่งวัตถุต่าง ๆ 

 6. แถบแสดงสถานะ (Status Bar) คือ แถบแสดงสถานะการท างานของไฟล์ที่ก าลังใช้
งานอยู่ เช่น แสดงขนาดของไฟล์ แสดงเวลาในการท างาน เป็นต้น 

 
 
 
 
 
 

 1 
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 1)  ขั้นตอนการออกแบบภาพกราฟิกส่วนหัวเว็บไซต์  
   1.  เปิดโปรแกรม Adobe Photoshop CS6  
 
 

 
 

  2. คลิกเมนู File >> New  สร้างเอกสารใหม่  
 

 
 

  3. ก าหนดขนาดภาพหัวเว็บไซต์  Width:  1010 Pixels Height 200 Pixels  
Resolution : 72 Pixels/Inch ดังรูป 
 

 
 
 
 

   
 
 
 
 
 

 

1 

 
2 

 3 
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  4. จะได้ขนาดภาพที่จะให้ท าหัวเว็บไซต์ดังรูป 
 

 
 

   5. คลิกท่ีเมนู File  เลือก Open  หรือกดคีย์ลัด Ctrl+O  
 

 
 

  6. จะปรากฏหน้าจอ Open เลือกรูปภาพ Logo คลิก Open ดังรูป 
 

 
 
 
 
 
 

4 

5 
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   7. จะปรากฏหน้าต่าง Logo ขึ้นมา ใช้เครื่องมือ Move Tool ลากจากหน้าต่าง  Logo 
มายังหน้าต่าง หัวเว็บไซต์ ปรับขนาดให้เหมาะสม ดังรูป 
 

 
 

   8. ที่หน้าต่าง Layer คลิกท่ีปุ่ม Create new Layer เพ่ือสร้าง Layer ขึ้นมาใหม่ 
   9. จะได้ Layer 2 ขึ้นมาใหม่ดังรูป 
 

 
 

   10. ที่เครื่องมือ Tool bar ที่เครื่องมือ Rectangle Tool  คลิกปุ่มสามเหลี่ยมด้านล่าง 
เลือกเครื่องมือ Rounded Rectangle Tool  
 

 

7 

9 
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   11.  คลิกเลือกสีเติม (Fill) สีเส้น (Stroke)  ตามต้องการ 
 

     

   12. วาดรูปร่างที่ส่วนหัวเว็บไซต์ดังรูป 
 

 
 
 

   13. สร้างเส้น Guide ขึ้นมาเพ่ือให้วางวัตถุได้ตรงกัน โดยคลิกที่ค าสั่ง View >New Guide  
   14. จะปรากฏหน้าต่าง New Guide ขึ้นมา ก าหนดแนว เป็นเส้นแนวนอนเลือก 
Horizontal ก าหนด ต าแหน่งเส้น Position เป็น 2 cm  คลิก ดังรูป 
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12 
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   15. จะได้เส้น Guide ตามท่ีก าหนดดังรูป 
 

     

  16. ที่เครื่องมือ move tool คลิกท่ีรูปร่างที่สร้างไว้ กด Alt ที่แป้นพิมพ์ค้างไว้ ลากจะได้
รูปร่างเพ่ิมขึ้นมาอีก ท าการคัดลอกให้เต็มส่วนหัวดังรูป 
 

 
 

   17. ที่เครื่องมือ Tool bar คลิกเครื่องมือ T เพ่ือพิมพ์ตัวอักษร ตามที่ต้องการดังรูป 

 

 
 
 
 
 
 
 
 
 

 

15 
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   18. ที่แถบ Option ด้านบน ปรับแต่งตัวอักษรและขนาดให้สวยงาม 

 

 
 

  19. น าภาพสินค้ามาตกแต่งเพ่ิมเติม โดยการคลิกที่เมนู File เลือก Open 
  20. จะปรากฏหน้าจอ Open เลือกรูปภาพที่ต้องการเปิด  
  21. คลิก Open ดังรูป 
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   22. จะเห็นว่า Layer รูปภาพจะล็อคเอาไว้ ดับเบิลคลิกที่ Layer รูปภาพที่ถูกล็อค       
จะปรากฏหน้าต่าง New layer ขึ้นมา คลิก ok  
  23. เครื่องหมายล็อคจะหายไปดังรูป 
 

 
 

 
    

           ค าสั่งต่าง ๆ ในโปรแกรม Adobe Photoshop ในการปรับสีรูปภาพมีดังนี้ 
 - ค าสั่ง Levels เป็นค าสั่งที่ใช้ปรับสีและแสงเงาให้กับรูปภาพ 
- ค าสั่ง Auto Levels เป็นค าสั่งที่ใช้ปรับความมืดและความสว่างให้กับภาพแบบ 

อัตโนมัติ 
- ค าสั่ง Auto Contrast เป็นค าสั่งที่ใช้ส าหรับความต่างของความมืดและความสว่าง 

 ให้กับภาพแบบอัตโนมัติ 
- ค าสั่ง Auto Color เป็นค าสั่งที่ใช้ปรับสีและความต่างระหว่างความมืดและความ

สว่างให้กับภาพแบบอัตโนมัติซึ่งช่วยแก้ปัญหาสีเพี้ยน 
- ค าสั่ง Curves เป็นค าสั่งที่ใช้ปรับสีและแสงเงาให้กับรูปภาพโดยใช้เส้นในการปรับ 
- ค าสั่ง Color Balance เป็นค าสั่งที่ใช้ปรับความสมดุลให้กับภาพหรือใช้เปลี่ยนสี

ภาพเหมาะกับการปรับแก้ภาพเก่าให้ดูใหม่ขึ้น  
- การใช้ค าสั่ง Hue/Saturation เป็นค าสั่งที่ใช้ปรับสีและแสงเงาให้กับรูปภาพ 
- ค าสั่ง Brightness/Contrast เป็นค าสั่งที่ใช้ปรับแสงสว่างและความชัดของภาพ

แบบมีผลกับทุกพิกเซลเท่า ๆ กัน จึงท าให้ง่ายต่อการใช้งาน 
  24. คลิกท่ีเมนู Image > Adjustment >  Brightness/Contrast  
   25. จะปรากฏหน้าต่าง Brightness/Contrast ให้เลื่อนปรับความสว่าง ที่ Brightness: 
ปรับความมืดที่ Contrast:  ตามต้องการ  
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    26. เมื่อได้ภาพที่สวยงามแล้ว คลิกที่ ok 
 

 
 
 
 
 
 
 27.  ใช้เครื่องมือ move tool ดึงหน้าต่างรูปภาพแพนเค้กขึ้นมา 
 28.  ใช้เครื่องมือ move tool ลากรูปภาพมาท่ีหน้าต่าง หัวเว็บไซต์ที่ออกแบบไว้  
 29.  ปิดหน้าต่าง รูปภาพแพนเค้กโดยไม่ต้องบันทึก คลิกท่ีเครื่องหมาย x ดังรูป 

 

 
 

    30.  ปรับขนาดของภาพให้มีขนาดเล็กลง กด Ctrl+T จะปรากฏกรอบให้ปรับขนาดและ
หมุนภาพได้ตามต้องการ  เมื่อได้ขนาดที่ต้องการแล้วกด Enter  
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  31.  ใส่กรอบให้รูปภาพคลิกที่เมนู Edit >Stroke  
  32.  จะปรากฏหน้าต่าง Stroke ขึ้นมา ก าหนดขนาดเส้นและสีเส้นตามต้องการเสร็จแล้ว
คลิก ok 
  33. จะได้กรอบที่รูปภาพดังรูป 
 

 

 
  34. เพ่ิมรูปภาพเข้ามาอีกรูปและปรับแต่งให้สวยงามตามข้ันตอนที่ 19-33 ดังรูป 
 

 
 

   35. บันทึกไฟล์ คลิกที่เมนู File เลือก Save for Web หรือกด Alt+Shift+Ctrl + S               
   36. จะปรากฏหน้าต่าง Save for Web ให้เลือกประเภทของไฟล์เป็น JEPG High  
   37. คลิกท่ีปุ่ม Save ดังรูป 
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   38. เลือกแหล่งที่เก็บไฟล์ที่ช่อง Save in: 
   39. พิมพ์ชื่อไฟล์ที่ช่อง File name:     
   40. คลิกปุ่ม Save ดังรูป 
 

 
 

    41. จะได้ไฟล์ภาพกราฟิกท่ีใช้ส าหรับส่วนหัวเว็บไซต์ดังรูป 
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4.3 ความหมายและความส าคัญของภาพเคลื่อนไหวส าหรับเว็บไซต์ 
ภาพเคลื่อนไหว หมายถึง  ภาพที่ถูกสร้างขึ้นโดยการน าภาพนิ่งหลาย ๆ ภาพมาฉาย

ต่อเนื่องกันด้วยความเร็วสูง ท าให้เกิดภาพลวงตาของการเคลื่อนไหว โดยปกติความเร็วของ
ภาพเคลื่อนไหวจะฉายด้วยความเร็วที่ต่างกันขึ้นอยู่กับชนิดของการแสดงผล (output) การน า
ภาพเคลื่อนไหวมาใช้ส าหรับเว็บไซต์นั้นจะท าให้เว็บไซต์มีความน่าสนใจน่าตื่นเต้นมากกว่าการสร้าง
เว็บไซต์จากภาพนิ่งธรรมดา ประเภทของภาพเคลื่อนไหว แบ่งได้เป็น 2 ประเภทคือ  

1) ภาพเคลื่อนไหวแบบ 2 มิติ (2D Animation) จะมองเห็นได้ทั้งความสูงและความกว้าง  
ซึ่งจะมีความเหมือนจริงพอสมควรและการสร้างจะไม่สลับซับซ้อนมากนัก เช่น ภาพเคลื่อนไหว         
ที่ปรากฏตามเว็บไซตต์่างๆ รวมทั้งภาพที่มีนามสกุล .Gif ,.swf เป็นต้น 

2) ภาพเคลื่อนไหวแบบ 3 มิติ (3D Animation) จะมองเห็นได้ทั้งความสูง ความกว้าง และ
ความลึก ภาพที่เห็นจะมีความสมจริงมากที่สุด เช่น ภาพยนตร์ต่าง ๆ  เป็นต้น 

 

4.4 การออกแบบภาพเคลื่อนไหวที่ใช้ส าหรับเว็บไซต์  
การออกแบบภาพเคลื่ อนไหวที่ ใช้ส าหรับเว็บไซต์  สิ่ งส าคัญที่ควรค านึงถึ งในการน า

ภาพเคลื่อนไหวมาใช้ในงานเว็บไซต์คือ ขนาดของไฟล์ภาพจะต้องไม่ใหญ่เกินไปเพราะในการโหลด
ภาพที่มีขนาดใหญ่มาก ๆ จะท าให้การแสดงผลของเว็บไซต์ช้า  โปรแกรมที่ใช้ในการออกแบบ
ภาพเคลื่อนไหวส าหรับเว็บไซต์ คือ โปรแกรม Adobe Flash ซึ่งเป็นโปรแกรมที่มีความนิยมสูง และ
เหมาะส าหรับการสร้างชิ้นงานภาพเคลื่อนไหว ส่วนประกอบของโปรแกรม Adobe Flash มีดังนี้ 

 
 

 
 

1.  Menu Bar คือ เมนูบาร์ เป็นส่วนส าหรับแสดงรายการค าสั่งต่าง ๆ ของโปรแกรม 
2.  Stage คือ พ้ืนที่การท างาน เป็นส่วนที่ก าหนดขอบเขตขนาดของการท างาน เป็นพ้ืนที่ส่วน  

ที่ใช้ในการวางวัตถุต่าง ๆ  

 1 

 3 

 2 
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3.  Timeline คือ แถบควบคุมการเคลื่อนไหวของวัตถุ เป็นส่วนที่ใช้ในการก าหนดการท างาน
และก าหนดการน าเสนอผลงาน การเคลื่อนไหวต่าง ๆ ในรูปแบบต่าง  ๆ 

4.  Tool Box คือ แถบเครื่องมือ เป็นแถบที่รวบรวมเครื่องมือต่าง  ๆ ที่ใช้ในการสร้างวัตถุ     
เช่น สร้างรูปร่าง ข้อความ การใส่สีให้กับวัตถุ เป็นต้น 

5.  Properties คือแถบก าหนดคุณสมบัติ เป็นส่วนที่ใช้ก าหนดคุณสมบัติให้กับวัตถุต่าง ๆ        
ทีเ่ลือกอยู่ในขณะนั้น เช่น การก าหนดขนาดของพ้ืนที่การท างาน การก าหนดคุณสมบัติการเคลื่อนไหว     
ของวัตถุ เป็นต้น 

6.  Panels คือหน้าต่างที่รวบรวมเครื่องมือต่าง ๆ ส าหรับใช้ในการปรับแต่งวัตถุ เช่น Property 
Inspector  เป็นหน้าต่างที่ใช้แสดงคุณสมบัติต่าง ๆ ของวัตถุที่เลือก  Filters เป็นหน้าต่างที่ใช้
ปรับแต่งหรือเป็นการใส่ effect ให้กับตัวอักษรหรือวัตถุอื่น ๆ Color  เป็นหน้าต่างที่เลือกใช้สีและใส่สี
ให้กับวัตถุ เป็นต้น 

1) ขั้นตอนการออกแบบภาพเคลื่อนไหว ด้วยโปรแกรม Flash Professional CS6 
 1. คลิก Start >>All programs >> Adobe Flash Professional CS6 
  2. จะปรากฏหน้าต่างโปรแกรมให้เลือกที่แถบ Create New โดยสามารถเลือกสร้างแบบ 
ActionScript 2.0 เขียนค าสั่งต่าง ๆ ใช้งานเหมาะส าหรับผู้เริ่มต้นในการใช้โปรแกรม Abobe Flash 
และ  ActionScript 3.0 รองรับการท างานได้หลากหลายกว่า ActionScript 2.0 สนับสนุนการท างาน
แบบวัตถุมากขึ้น ท างานเร็วขึ้น เหมาะส าหรับผู้ที่มีความช านาญในการเขียนค าสั่งและสามารถใช้
เครื่องมือต่าง ๆ ใน Flash แล้ว  คลิกเลือก ActionScript3.0 ดังรูป  
 

  
 

  3. ปรากฏหน้าจอการท างานของโปรแกรม  
  4. คลิกท่ีแถบ Properties เพ่ือก าหนดขนาดการแสดงผลของหัวเว็บ โดยก าหนดค่าต่าง  
ดังนี้    
     ก าหนดค่า FPS: 24.00   การแสดงผลจ านวนภาพต่อ 1 วินาที 
     ก าหนดค่า Size: 1010 x 200 px ก าหนดขนาดการแสดงผลของ Stage 
                  ก าหนดค่า Stage  ก าหนดสีให้กับ Stage 
 

 

 1 
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 5. น ารูปภาพกราฟิกส่วนหัวเว็บไซต์ที่ได้ออกแบบไว้จากขั้นตอนที่แล้วเข้ามาโดยคลิกที่เมนู 
File > Import >Import to Stage 
  6. จะปรากฏหน้าต่าง Import เลือกรูปภาพหัวเว็บ  
  7. คลิก Open ดังรูป 

 
 
 
  8. รูปภาพที่เลือกจะปรากฏใน State ดังรูป 
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  9. ที่แถบ Timeline ดับเบิลคลิกท่ี Layer 1 เปลี่ยนชื่อเป็น หัวเว็บ ดังรูป 
 

 
 

  10. แทรกคีย์เฟรมให้แสดงผล 60 วินาที โดยการคลิกขวาเฟรมที่ 60 เลือก Insert 
Keyframe ดังรูป 
 

 
  11. ที่แถบ Timeline คลิก New Layer เพ่ือสร้างเลเยอร์ใหม่ดังรูป 
 

 
 

  12.  เลือกเลเยอร์หัวเว็บ คลิกรูปแม่กุญแจเพ่ือท าการล็อคไว้ไม่ให้มีการแก้ไขใด ๆ ดังรูป  
 

   

  13. คลิกท่ี Layer 2 คลุมเลือกตั้งแต่ เฟรมที่ 1-60 คลิกขวา Remove Frames เพ่ือลบเฟรม
เปล่าออก ดังรูป 
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  14. คลิกขวาที่เฟรมที่ 1 เลือก Insert Keyframes เพ่ือก าหนดคีย์เฟรมเริ่มต้น 
 

 
 

  15.  คลิกเครื่องมือ Rectangle Tool(R)  
          16.  เลือกสี โดยก าหนดAlpha:% = 40 
 17.  วาดรูปสี่เหลี่ยมที่นอก State ดังรูป 
 

  
    

  18. คลิกท่ี Fame ที่ 5 คลิกขวา Insert Keyframe 
   19. ใช้เครื่องมือ Selection Tool เลื่อนรูปภาพไปยังต าแหน่งที่ต้องการ 
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 20. ท าซ้ าข้ันตอนที่ 18-19 อีกครั้งในต าแหน่งที่ 10,15,20,15,30,35,40,45,50,55,60 ดังรูป 
 

    

 21. คลิกเลือกเฟรมที่ 1-60 คลิกขวา Create Classic Tween 
 

 
 

  22.จะปรากฏคีย์เฟรมขึ้นมาดังรูป 
 

 
 23. สามารถก าหนดรูปแบบการเคลื่อนไหวที่หน้าต่าง Properties ในช่อง Tween ดังนี้ 

 Rotate = ใช้ก าหนดการหมุนในแต่ละช่วงเฟรม 
             - None = ไม่ให้ท าการหมุน 

   - Auto = หมุนวัตถุแบบก าหนดเอง (หมุนแบบระยะสั้น ๆ) 
    - CW (Clockwise) = ก าหนดให้หมุนตามเข็มนาฬิกา 
    - CCW (Counter Clockwise) = ก าหนดให้หมุนทวนเข็มนาฬิกา  

 Snap = ก าหนดให้วัตถุยึดกับเส้น Path  
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 Orient to path = ก าหนดให้วัตถุหันทิศทางตามเส้น Path  
 Sync = ปรับความเร็วให้เท่ากันระหว่าง Timeline หลัก และ Timeline ย่อย  
 Scale = ปรับขนาดวัตถุ ตั้งแต่เฟรมแรกไปจนถึงเฟรมสุดท้าย   
 

    

 24. คลิกท่ีเมนู File >> Export >> Export Movie  
 25. ปรากฏหน้าจอ Export Movie เลือกต าแหน่งเก็บไฟล์ พิมพ์ชื่อ header.swf 
 26. คลิก Save  
 

  
 

  27. จะได้ไฟล์หัวเว็บไซต์ที่เป็นภาพเคลื่อนไหวดังรูป 
 

 
 
 

 

  23 

  24 

  25 

  27 

  26 


